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Maya Intermediate Standards  
 
Based on a long-term commitment to education, Autodesk Media & Entertainment is providing 
a set of standardized topics and features to help trainers and educational institutions develop 
the necessary skills to teach Maya. These standards are the result of extensive interviews with 
artists, trainers, and managers at prestigious game and film companies. They ultimately 
provide the Maya community with clear definitions and benchmarks for user skill levels.  
The standards consist of a set of industry-specific topics common to all skill levels. For each 
skill level, a set of appropriate Maya features is defined for each topic. Initially, 2 levels of 
competency have been established:  
 

• Fundamentals & Intermediate (Level 1) 
• Advanced (Level 2) 

 
The Maya Standards have the following goals:  
  

• Ensure users/students achieve a level of knowledge of Maya beyond the 
fundamentals, and allow them to become more technically proficient and productive 
with the software.  

• Standardize the requirements for Intermediate training on Maya.    
• Provide a clear picture for everyone on what should be learned and taught at this 

level.  
• Provide a basis of technical knowledge for instructor certification   

Competency Levels  
Completing one or more of the instructional levels does not establish the instructor’s level of 
knowledge in Maya.  For example, an instructor’s interest in teaching fundamentals does not 
necessarily mean their knowledge is limited to only fundamentals.  In fact, most instructors 
teaching at the Fundamental level are accomplished and established Maya users.    
  
Completing Advanced Level certification does not mean the instructor is certified at the 
Fundamental level.  The skill set to teach fundamentals is quite different than the skill set 
required teaching an advanced audience.  

Industry Specific Topics  
In each level of instruction and certification the Topics below will be covered. Each topic’s 
coverage will vary according to the level. For example, more modeling might be covered in the 
Fundamentals and Intermediate levels, while Scripting receives only a small amount in 
fundamentals. Once in the Advanced and Expert Levels, the amount of time spent on 
modeling vs. scripting might be entirely reversed. 
 

1. UI/Scene Management  
2. Modeling 
3. Camera  
4. Lighting 
5. Rendering 
6. Materials/Textures 
7. Global Illumination   
8. Animation 
9. Effects  
10. IK / Rigging 
11. Dynamics 
12. Scripting  
13. Scene Assembly 

  
Maya Intermediate Learning Standards 
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The learning standards for Maya intermediate are described below. Each item in the list is the 
smallest teachable piece of content. 
 
During the workshop, the instructor is given 2 topics to teach during the workshop.  The 
allotted presentation time for each topic is one hour. The instructor chooses from the topic and 
decides what they will cover for that Module.  
 
 
 
Topic Sub-Topic Content 
UI/Scene Management   

 Preferences>Interface Interface 

 Preferences>UI Elements Visible UI Elements 
Editor in Main Window 
Panel Configurations 

 Preferences>Help Heads Up Display 
Popup Help 

 Preferences>Display Performance 
View 

 Preferences>Manipulators Manipulator Sizes 

 Preferences>Settings World Coordinate System 
Working Units 

 Preferences>Files/Projects Project Settings 
Recent History Size 

 Preferences>Timeline Timeline 
Playback 

 Preferences>Undo Undo 

 Preferences>Save Actions Preferences and Settings 

 Preferences>Modules Load on Startup 

 Preferences>Applications Application Path for Viewing Images 
Application Path for Viewing 
Sequences 

 UI Navigation/Interaction Custom Menu Sets 
Hotkey Editor 
Color Settings 
Marking Menu Editor 
Shelf Editor 
Panel Editor 

 Settings/Preferences>Plug-In 
Manager 

Loaded vs. Auto Load 
Getting Plug-in Information 
Demo loading / unloading Plug-Ins 

 Selection of Objects Selection Sets 
Select Hierarchy (Demo selecting only  
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templated objects in viewports) 

 Transforms Offset object (+= / -= in transform field) 
Reset Transformations 
Freeze Transformations 
Snap Align Objects 
Align Objects (Options Dialog) 

 Object Management Measure Tools 
Annotation 

 Channel / Attribute 
Management 

Keyable vs. Nonkeyable Attributes  
Locked vs. Non Locked Attributes 
Channel Control UI 
Connection Editor 
Demo making / breaking Node 
connections using the Connection 
Editor 

 Channel Box UI Customization Settings (Change 
Precision, Reset to Default) 
Channel Names (Nice, Long, Short) 
Resizing the Channel Box 

 Hypergraph UI Hypergraph Scene Hierarchy 
Hypergraph Input and Output 
Connections 
Demo making / breaking Node 
connections in the Hypergraph 

 
Topic Sub-Topic Content 
Modeling I   

 Creating Reference Material Lecture 

 Collecting Reference Material 2D Images 
3D Objects 

 Set up scenes for Reference 
Material  

Image Plane(s)  
Construction Plane(s) 
Template / Untemplate Objects 

 Path-driven Geometry 
Creation 
 

Create Animation Snapshot 
Create Animated Sweep 
(Discuss advantages of turning on/off 
Construction History during creation) 

 Maya Modeling Paradigms Discuss general pros/cons of each 
paradigm and which geometry type is 
suitable to various modeling tasks 

 NURBS Concept Curve / Surface Degrees 
Curve / Surface Parameterization (i.e. 
Knot Spacing) 
Open, Closed, and Periodic Geometry 
Curve / Surface Continuity 
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Curve / Surface Direction 
NURBS UVs (Discuss relationship to 
surface creation) 
Modify>Convert (Options for NURBS) 

 2D NURBS Curve Tools Adobe Illustrator Object 

 NURBS Curve Editing Edit Curves Toolset (All Options) 
Reverse Curve Direction 
Rebuild Curve 

 NURBS Curve Networks Definition / Lecture 
Workflow Demo 
Build a simple curve network with 
cross-sectional, span, and/or boundary 
curves for workflow example 

 3D NURBS Surface Tools Surfaces Toolset (All Options) 
Birail Tools 
Boundary Tool 
Square Tool 
Bevel / Bevel Plus Tool 

 NURBS Component Editing Display>NURBS>Normals (Shaded 
Mode) 
Display>NURBS>Patch Centers 
Display>NURBS>Surface Origins 
Move Normal Tool 

 NURBS Surface Editing Edit NURBS Toolset (All Options) 
Reverse Surface Direction 
Rebuild Surfaces 
Sculpt Geometry Tool (Demo Artisan) 

  Soft Modification Tool 

 NURBS Trim Modeling Definition / Lecture (Discuss pros & 
cons of Trimming 
Trimming options 
Tessellation of trimmed objects 

 NURBS Trim Modeling (build 
real object) 

Build object (Ex. Toaster, TV Set, 
etc…) to demonstrate Trimming 
Workflow 

 NURBS Patch Modeling Definition / Lecture (Discuss pros & 
cons of Patching) 
Workflow Demo 

 NURBS Stitching Definition / Lecture 
Stitch Edges Tool 
Global Stitch 
Workflow Demo 

 NURBS Patch Modeling 
(build real object) 

Build object (Ex. Teddy Bear, Human 
Hand, etc…) to demonstrate Patching 
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& Stitching Workflow 

 NURBS Surface Deformation 
Tools 

Sculpt Deformers 
Wire Tool 
Wrap Deformers 

 Animated Sweep Demonstrate 

 Preferences>NURBS Display Settings for new NURBS 
Objects 

 Preferences>Modeling Output Geometry Type 
NURBS Interaction 

 Preferences>Settings Tolerance 

Modeling II   

 Polygon Concept Planar vs. Non-planar Faces 
Non-manifold geometry 
Managing Poly Count (Discuss 
concerns associated with model 
complexity and/or interactivity)  
Modify>Convert (Options for Polys) 

 Polygon Tools Mesh Toolset (All Options) 
Combine / Separate  
Booleans 
Smooth (Discuss potential Poly Count 
concerns) 
Create Polygon Tool 
Sculpt Geometry Tool (Demo Artisan) 
Mirror Geometry 

 Polygon Component Editing Custom Polygon Display 
Surface normals 
Face normals 
Vertex normals 

  Select Edge Loop Tool 
Select Edge Ring Tool 
< = Grow Selection Region 
> = Shrink Selection Region 
Move Normal Tool 

 Polygon Surface Editing Edit Mesh Toolset (All Options) 
Extrude 
Keep Faces Together 
Split Polygon Tool 
Add Divisions 
Merge (Vertices, Edges) 
Delete Edge/Vertex 
Bevel 
Subdiv Proxy (discuss in relationship 
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to low vs. high poly modeling) 
Demo Subdiv Proxy workflow with 
object such as a simple character  

 Polygon Modeling (build real 
object) 

Build object (Ex. Biped Character, Sofa 
w/ Cushions, etc…) to demonstrate 
advanced Polygon modeling Workflow 

 Polygon Surface Deformation 
Tools 

Sculpt Deformers 
Wire Tool 
Wrap Deformers 

 Preferences>Polygons Display Settings for new Polygon 
Objects 

 Preferences>Modeling Output Geometry Type 
Polygons 

Modeling III   

 Subdivision Surface Concept 
 

Discussion (Hybrid nature) 
Subdiv Surface components 
Standard Mode vs. Polygon Proxy 
Mode 
Hierarchy Levels (Concept) 
Viewport Display Resolution 
Modify>Convert (Options for Subdiv) 

 Subdivision Surface Tools 
 

Subdiv Primitives 
Sculpt Geometry Tool (Demo Artisan) 

 Subdivision Surface Editing Edge Crease 
Refine Selected 
Display Level / Display Filter 

 Subdivision Surface 
Modeling 

Workflow Demo 

 Subdivision Surface 
Modeling (build real object) 

Extrude 
Add Divisions 
Refine Selected 

 Preferences>Subdivs Display Settings for new Subdiv 
Objects 

 
 
Topic Sub-Topic Content 
Camera   

 Camera Theory 
 

Lecture on basic cinematography 
Eliminating unnecessary camera 
moves 
Eliminating robotic looking camera 
moves 
Hand-Held look 
Framing and Composition 
Jump cuts  
Crossing the axis / 180 degree rule 

 View Menu Settings 
 

Depth of Field 
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Predefined Bookmarks 
Custom Bookmarks (Bookmark Editor) 
Panels>Look Through Selected 

 View>Camera Settings Gates (No, Film, Resolution) 

 Turntables  Animate>Turntable… 

 Motion effects (Motion Blur) Focus and Blur 
2D vs 3D (Pros vs. Cons) 

 Preferences>Cameras Default Cameras (setting Near/Far Clip 
Planes) 
Animate Camera Transitions 

Lighting I   

 mental ray Light types  Valid light types (point, spot, 
directional, area) 

 Standard mental ray Light 
attributes 

Caustic and Global Illumination 
Shadow Map Attributes 
Detail Shadow Map Attributes 

 Specific mental ray Lights mental ray Area light 
mental ray Area light Attributes 
Converting spot lights to mental ray 
Area lights (known issues) 

Lighting II   

 Layers Using Layers to manage your light 
setups/rigs 

 Common Light attributes Decay Rate 
Decay Regions 
Custom decay rate 
Emit Diffuse 
Emit Specular 
Illuminates by Default 
Color Mapping 

 Depth Map Shadows 
 
 

Advantages/Disadvantages of Dmap 
Shadows 
Optimizing with disk based dmaps (i.e. 
Reusing depth maps) 
Troubleshooting Dmap Shadows 

 Raytraced shadows 
 
 
 

Advantages/Disadvantages of 
Raytraced Shadows 
Incompatibility with IPR 
Troubleshooting Raytraced Shadows 
(ex. Self-shadowing “Terminator” 
effect) 

Rendering   

 Render Settings UI Common Tab 
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 Render Flags UI Explanation of UI 

 Render Layer Editor Lecture (concept and uses) 
Explanation of UI 

 IPR rendering 
 

Discussion - Interactive Photorealistic 
rendering uses and limits 
Demonstrate Workflow 

 Maya Hardware Renderer 
 
 

Lecture – Uses 
Hardware render basics 
Render Settings>Maya Hardware Tab 
Hardware Render Buffer Dialog 
Demo 

 Maya Vector Renderer Lecture - Uses 
Output options (Bitmap vs Vector) 
Vector output types 
Render Settings>Maya Vector Tab 
Demo 

 Maya Software Renderer Anti-aliasing Quality (Edge anti-
aliasing, Shading Samples, Multi-Pixel 
Filtering, etc…) 
Field Options 
Render Options 
Memory & Performance Options 

 mental ray Renderer Quality presets 
Anti-aliasing Quality (Shading 
Samples, Multi-Pixel Filtering, etc…) 

 Raytracing 
 

Lecture - absorption, reflection, and 
refraction of Light 
Enabling via Maya Software & mental 
ray 
Reflection Levels 
Refraction Levels 

 Controlling renders Discussion of scene optimization 
techniques 
Reflection / Refraction Limits 
Workflow using Render Flags UI 

 Introduction to Network 
Rendering 

Lecture 
Batch Render Dialog 

 
 
Topic Sub-Topic Content 
Materials/Textures I   

 Real world materials and 
referencing that information 
in the Hypershade 

Lecture and Demonstration 
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 Special Use Surface Materials Layered Shader 
Ramp Shader 
Shading Map 
Surface Shader 
Use Background 

 Common Surface Material 
Attributes 

Ambient Color 
Incandescence 
Translucence 
Diffuse 
Reflectivity 
Reflected Color 

 Shared Surface Material 
Attributes 

Special Effects 
Matte Opacity 
Raytrace Options 
mental ray (Enabling 
reflection/refraction blur) 

 Special Use Textures PSD File 
Water 
Layered 

 Environment Textures Env Ball 
Env Chrome 
Env Cube 
Env Sky 
Env Sphere 

 Image/Movie Textures Filter Type 
Interactive Image Caching 
HDRI Preview Options  
(Discuss) Importance of resolution 
(Discuss) Importance of tileable maps 

 General / Color Utilities Multiply Divide 
Stencil 
Blend Colors 
Contrast 
Remap 
Switch (Discuss concept and uses) 

 Shading Group Node 
Attributes 
 

Surface Material 
Displacement Material 
Volume Material 
mental ray custom options 

 mental ray Shaders 
 
 
 
 

Material Shaders 
Photon Shaders 
Shadow Shaders  
Volume Shaders 



Maya Intermediate Standards 

 Photon Volume Shader 
Contour Shader 

 Hypershade UI 
 

Managing the UI and work areas 
Bins 
Custom Tabs 

 Building complex shading 
networks 

Demo shader development using 
Hypershade.  Create a shader with the 
complexity level of a vintage wine glass 
with decal or helmet with team logo 
and surface abrasions, etc… 

 Hypershade>Edit Menu 
Options 

Explain and demonstrate options 

Materials/Textures II    

 2D Texture Mapping Options Normal 
Projection 
Stencil 

 UV Mapping Using the Show Manipulator Tool to 
edit UV projections 

 Confirming UV placement Create UVs> Assign Shader to Each 
Projection 

 UV Texture Editor UI UI Navigation 
UV Texture Editor Menu Bar (All 
Options) 

 UV Sets Discuss concept 

 Describe the UV 
creation/editing workflow 
with a demonstration that 
takes into account the 
following 

UV Texture Editor and navigation 
Standard Mapping Options 
Selection Modes 
Using the Transform Manipulator 
Using common UV Editing Tools 

 Baking Illumination and Color 
(aka Pre-lighting) 

Lecture (concept and uses) 
Creating bake sets 
Texture Bake Set Attributes 
Vertex Bake Set Attributes 
Convert to File Texture 
Baking with Global Illumination and 
Final Gather 

 Transfer Maps (aka Normal 
Maps) 

Lecture (concept and use) 
Transfer Maps Dialog 
Target vs. Source Objects 
Output Maps 
Software Render Options 

 File (Image) Texture Quality File texture filtering 
mental ray Texture Filtering (Elliptical 
Filters) 

 Texture Memory Management Block ordered textures (BOT Files) 
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Memory mapped files (mental ray) 

Global llIumination   

 Overview of Global 
Illumination in mental ray 

Using Global Illumination 
GI Terms and Techniques 
Call-up complex renderings that 
showcase GI-related features to 
illustrate each component. 
Basic demonstration of GI workflow 
and feature-set 
Show examples that illustrate 
difference between “fakeosity” and real 
GI 

 Caustics and Global 
Illumination (Dropdown)  

Enabling GI 
Rebuild Photon Maps (discuss 
advantages) 

 Overrides (Dropdown) Discuss (uses) 
Enabling Overrides 
Global / Local Workflow 

 HDRI / IBL HDRI Lecture (concept and uses) 
Image-Based Lighting (Dropdown) 
Image-Based Lighting node attributes 
IBL with HDRI (Demonstrate workflow)  
Approximation Editor 

 
 
Topic Sub-Topic Content 
Animation I    

 Lecture – Animation 
Techniques 

Theory of traditional 2D Animation 
techniques for example 
Exaggerated and Secondary Motion 
Anticipation 
Squash and Stretch 

 Kayframing (Process) In-Betweens (concept) 
Demo adding and removing in-
betweens 
Breakdowns (concept) 
Demonstrate animating using Keys and 
Breakdowns 
Ghosting / Unghosting (Object Display 
Dropdown in Attribute Editor) 
 

 Graph Editor Scale Keys 
Add keys vs. Insert keys 
Lattice Deform Keys 
Snap Keys 
Change Curve Color 
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Curves>Spreadsheet… 
Weighted vs. Non-Weighted Tangents 
(concept) 
Lock/Free Tangent Weight 
Switching to Dope Sheet/Trax Editor 

 Dope Sheet Clearly identify workflow for Dope 
Sheet and Curve Editor. For example, 
using Dope Sheet for Timing and 
Curve Editor for Animation (time 
space) 
Explanation of UI 
Demonstrate timing process 

 Trax Editor Lecture (non-linear animation) 
Explanation of UI 
Demonstrate clip editing process 

 Audio Import Audio File  
Enabling Timeline display 
Audio Attributes>Offset 
Audio Playback 

 Set Driven Key Discuss Concept (Driver vs. Driven) 
Explain UI 
Demonstrate workflow 

 Animation Expressions Lecture (concept) 
Expression Editor UI 
“Time” & “Frame” keywords 
Demonstrate using examples 

 Preferences>Animation Auto Key 
Euler vs. Quaternion (Lecture) 
Rotation Interpolation 
Tangents 
Animation Blending 

Animation II   

 Motion Path-based animation Flow Path Object (Demo) 
Animation Snapshot (Demo) 

 Baking animations Usage 

 Constraints Point 
Orient 
Parent 
Geometry 
Normal 
Tangent 
Discuss importance of weighting 
constraints  
Set Rest Position 
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 Deformers Sculpt 
Cluster 
Jiggle 
Wire 
Wrap 
Changing Deformation Order 
Deformation Sets 
Editing deformation sets with Paint Set 
Membership Tool 

 Full Body IK 
 

Intro FBIK (Full Body IK) 
Definition and usage 

    
Topic Sub-Topic Content 
Effects   

 Particle Attributes Explanation of various particle 
attributes 
Lifespan Mode 
Lifespan Random 
Start Frame 
Lifespan 
Max Count 

 Emitter Attributes Explanation of various emitter 
attributes 
Rate 
Max / Min Distance 
DirectionXYZ 
Spread 
Speed 
Away from Center 
Away from Axis 
Around Axis 

 Particle Shape Render 
Attributes 

Adding attributes for Current Render 
Type (concept) 
Demonstrate process 

 Goals 
 

Create Goals 
Goal weights 
Goal smoothness 
Conserve 

 Particle Collision Events Particle Collision Event Editor 
Explanation of UI 
Creating & Modifying Events 

 Caching particle simulations 
 

Discuss concept, types, and uses 
Memory Caching 
Create Particle Disk Cache 



Maya Intermediate Standards 

dynGlobals node 
Oversampling (concept) 
Demonstrate example using memory 
and/or disk caching 

 Particle rendering Hardware Render Buffer UI 
Multi-pass render options 
Matte opacity 

 Pre-built Effects Create Smoke 
Create Shatter 
Create Curve Flow 
Create Surface Flow 

 2d Paint Effects 2d Brushes (Demo examples) 
Dynamics simulations with Paint FX  
Compositing with Paint FX 

 3d Paint Effects 3d Brushes (Demo examples) 
Dynamics simulations with Paint FX  
Paint FX to Polygons, NURBS, Curves 
Paint FX and mental ray 
Compositing with Paint FX 

 Volumetric / Material Effects ShaderGlow 
Env Fog 
Particle Cloud 
Volume Fog 
Volume Shader 

 Light Effects Light Fog 
Light Glow 
Creating Glows, Halos, and Lens 
Flares using Optical FX Utility 

IK / Rigging   

 Hierarchical animation Discuss advantages 
Demonstrate basic example 

 IK Rig Lecture (armature example) 

 Creating skeletons Complex joint hierarchies 
Scaling joints 
Cartoon rigs 

 Parenting geometry to 
skeletons 

Demonstrate process 

 IK Handles SC IK (single chain) 
RP IK (rotate plane) 
Spline IK 

 IK/FK blending Definition and usage 

 FBIK Lecture (process & workflow) 
Preparing the character 
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Preparing the skeleton 
Create the FBIK system (aka 
Characterize FBIK) 
Posing FBIK 
Set FBIK Keys 

 Constraints 
 

Pole vector – preventing flipping joints 

 Building character rigs 
 

Create an example, such as a leg and 
foot or body and tail utilizing: 
Channel control 
Set driven key 
Custom attributes 
Hypergraph 
Custom control objects 
Deformation order 

 Skinning 
 

Rigid binding 
Smooth binding 
Weight normalization 

  Demonstrate the general workflow and 
concept of skinning as it relates to 
character rigging 

 Editing Skin Weights 
 

Edit Membership (Tool options) 
Flexors 
Influence objects 
Paint Skin Weights Tool 
Copy skin weights 
Component Editor – Rigid Skins , 
Smooth Skins 
In-depth demonstration of workflow 
including skinning and editing skin 
weights. 

 Blend Shapes 
 

Lecture (concept) 
Targets 
In-between targets 
Blend Shape deformation order 
Paint Blend Shape Weights Tool 
Add Blend Shape manipulator 
(custom control object) 
Demonstrate Process 

 Preferences>Kinematics Inverse Kinematics 

Dynamics   

 Dynamic Relationships Editor Explanation of UI 
Demonstrate workflow 

 Rigid Bodies Active vs. Passive rigid bodies 
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Combining keyframing with rigid body 
dynamics 

 Rigid Body constraints 
 

Nail Constraint 
Pin Constraint 
Spring Constraint 
Hinge Constraint 
Barrier Constraint 
Rigid constraints and mass (concept) 

 Rigid Body optimization 
 

Surface Interpenetration 
Surface Normals 
Stand-in objects 

 Rigid Bodies and Particles 
 

geoConnector node 
Collision Layers 

 Soft Bodies Creation Options 
Soft Body Goals 
Goal PP 
Springs 
Paint Soft Body Weights Tool 

 Caching dynamic simulations 
 

Discuss concept, types, and uses 
Memory Caching 
Create Particle Disk Cache 
dynGlobals node 
Oversampling (concept) 
Demonstrate example using memory 
and/or disk caching 

 Preferences>Dynamics Dynamics 

Scripting   

 Macro Recording As viewed as an introduction to viewing 
a scripting language 

 Script Editor UI Explanation of UI 
Loading, Sourcing, and Saving Scripts 
Executing Commands 
Show Stack Trace 
Echo All Commands 

 Getting Help Discuss the importance of navigating 
within the Help Files 
Show the Maya help for a command 
Learning by examining Maya’s own 
Script Files 

 Scripting Reference MEL Command Reference 
Node and Attribute Reference 

 Getting and Setting Object 
Properties (Transform Node) 

MEL Command Syntax 
Attribute Names (overview) 
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getAttr 
setAttr 
Demonstrate through examples 

 Executing Simple Commands Creating objects with MEL (sphere 
command) 
Introduce flags (concept) 
Selecting objects with MEL 
Demonstrate through examples 

 Connecting Object Properties connectAttr 
Demonstrate through examples 

 Example:  Creating Objects Use the createNode command with 
relevant flags to make the transform, 
shape, and input node for a primitive 
object.  Then, connect the input and 
shape nodes to create and display the 
object’s wireframe in a scene. Finally, 
connect the shape node to the initial 
shading group to view the object in 
shaded mode. 

 Example:  Creating Interfaces Use the window command to create 
new UI elements.  Then add controls 
such as buttons and sliders to the UI. 

 Basic MEL Scripting Lecture (principles and process) 
Developing good MEL style 

 Introduction to Values and 
Variables 

Integers and floating point numbers 
Strings 
Variables 
Assigning values to variables and 
attributes 

 
 
Topic Sub-Topic Content 
Scene Assembly   

 Render Elements Lecture on why you use Render 
Elements.  Introduce combustion for 
compositing 

 Elements / Passes Beauty (concept) 
Alpha 
Diffuse 
Specular 
Shadows 
Z-Depth (Render Settings Dialog) 
GI 
Hardware particles 

 Import / Export File Format import/export 
considerations  
Data types and known issues 
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 File Referencing Unloading/reloading 
Namespaces 
Edits, List referenced edits 
Clean Reference 

 File>Recent… Files 
Increments 
Projects 

 Settings/Preferences>Plug-In 
Manager 

Loaded vs. Auto Load 
Getting Plug-in Information 
Demo loading / unloading Plug-Ins 

 


	Maya Intermediate Standards 
	Competency Levels 
	Industry Specific Topics 


